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Excel Statistics & Regression Tools Review Focus 

The focus of this assignment is on understanding the mechanics of running a 
regression analysis using Excel. In addition, Excel’s descriptive statistics 
generator is briefly explored. 
 
Excel includes a built-in regression tool in its Analysis ToolPak. Although the 
regression tool is relatively easy to use it has some limitations. For example, if 
you use multiple variables for the X range in the regression, the variables must 
be located next to one another in the worksheet. And, the regression outputs this 
tool generates are tightly packed into a worksheet making them relatively hard 
to read, especially if you choose to generate charts. 

 
 
Skills 

 The Data Analysis ToolPak Excel Regression  
 Naming Ranges 
 Excel Data Analysis ToolPak Descriptive Statistics  

 
 
Files You Need 

To complete the work for this assignment, download this file from the class 
“Review Files” web page: StatsRegr.xlsx.  

 
Deliverable 

Complete the Statistics and Regression Tools for Excel Review online quiz. 
 

 
Notes 

For your convenience the instructions in this assignment are divided into these 
sections: 
 
Completing the Assignment: Summary Descriptions 

Short descriptions of the assignment requirements, useful if you are 
already familiar with the core skills.  
 

Completing the Assignment: Detailed Descriptions  
More detailed descriptions of the assignment tasks and techniques, useful 
if you are unfamiliar with the assignment topics. You may find it helpful 
to have a good Excel reference guide on hand or to become familiar with 
Excel’s online help. 
 

A Skills Review Summary for this Assignment 
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Statistics and Regression Tools Review: Summary Descriptions 

Statistics and Regression Tools Review – Summary Descriptions 
 
 
Task 1: Use Excel to Run a Multiple Regression & Create a Chart of Results  
Use Excel’s built-in regression tool to analyze whether a variety of information about 
price, advertising, income, etc. collected by the Mrs. Smyth’s Gourmet Frozen Fruit Pie 
Company can predict company pie sales. Make the “Task 1–Pie Data” worksheet 
current. Then: 
1. Run the regression using Excel’s Analysis ToolPak regression option. Use the data in 

the Unit Sales column as the dependent, Y variable. Use the data in the Price, Ads, 
Comp_Price, Income, Population, and Time Var columns as the independent, X 
variables.  

2. Choose to output “Residuals” and “Standardized Residuals” and send the output to 
a new worksheet. Name the new worksheet “Task 2”. Position this sheet to the left of 
the “Task 2 – Pie Data” worksheet. 

3. Create a line chart comparing Unit Sales from the “Task 2–Pie Data” worksheet with 
the “Predicted (Q)” output in Excel’s “Residual Output” section of results. Locate the 
line chart to the right of the “Residual Output” section of Excel’s regression results. 

 
End of the Task 1 Summary Description 

 
Task 2: Use Excel’s Descriptive Statistics Generator to Analyze Data 
Make the “Task 2-Auto Imports” worksheet current. This sheet contains data on imports 
into the U.S. passenger car market from 1971 to 1997, comparing Korean, Japanese, and 
German import sales with sales of passenger cars manufactured in North America.  
1. Run Excel’s Analysis ToolPak “Descriptive Statistics” analysis on the data located in 

this worksheet. Do not include the “Year” column in the analysis. Select column 
headers for the rest of the data and make sure the “Labels in first row” option is 
checked. Send the descriptive statistics report to a “New Worksheet Ply” and request 
all the available outputs: Summary statistics, Confidence Level for Mean, Kth 
Largest, and Kth Smallest. Leave the settings for the confidence level, Kth largest, 
and Kth smallest at the defaults.  

 
 
 
 
 
 
 
Task 2 Intermediate Check 
In the set of initial results, many columns are not wide enough to display their data 
completely. In addition, Excel generates a column of descriptive statistics labels (Mean, 
Standard Error, Median, etc.) for each country/region analyzed (Columns A, C, E, and 
G). This label redundancy makes the output more difficult to read. 
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2. Edit the output so it has a single labels column at the left of the data and so that 

country/region names are above their data. Widen columns so all the data is visible 
and so your worksheet looks like the illustration below.  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

End of the Task 2 Summary Description 
 
 

End of the Statistics and Regression Tools Review Summary Description 
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Statistics & Regression Tools Review – Detailed Descriptions 
 
 
Task 1: Run a Multiple Regression with Excel & Create a Chart of Results  
 
Introduction 
Use Excel’s built-in regression tool to analyze whether information collected by the Mrs. 
Smyth’s Gourmet Frozen Fruit Pie Company about price, advertising, competitors’ 
pricing, etc. can predict company pie sales. Make the “Task 1–Pie Data” worksheet 
current and review the data. There are ten columns of data with forty-eight records.  

 
The illustration below shows a partial view of the data. 

 
For this regression operation: 
 

Use as the predictor variables (the independent or X variables) the data for Price, 
Ads, Comp_Price, Income, Population, and Time Var.  

 
Use as the predicted variable (the dependent or Y variable) the data for Unit 

Sales. Unit Sales holds actual sales data.  
 
Steps to Follow When Running a Regression with Excel 
 
1. Rearrange the Data as Necessary 
With Excel’s regression tool the independent X variables you use in your analysis must 
be located together in the worksheet. There must be no blank columns or columns-with- 
non-relevant data interrupting the range of X variables. The dependent Y variable need 
not be located adjacent to the X variables, but all Y variable values must be in a single 
unbroken column. These location specifications are required by Excel’s built-in 
regression tool.  
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For the data in the “Task 1–Pie Data” worksheet, you need not rearrange the data. The X 
variables are together in Columns F through K and the Y variable values are all in 
Column E. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
2. Run the Regression Analysis 
In the “Data” tab on Excel’s ribbon find the “Analysis” group and choose “Data 
Analysis”. 
 
 
 
 
 
 
 
 
 
 
 
 
Excel opens its “Data Analysis” dialog. Scroll down and find the “Regression” option. 
Click OK. 
 
 
 
 
 
 
 
 
 
 
 

Columns not used in 
the regression. 

Independent, X variables, 
located together in the 

worksheet. 
The dependent, 

Y variable. 
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The “Regression” dialog 
displays. This is the sole 
interface to Excel’s 
regression tool. All your 
interaction with Excel’s 
regression tool happens in 
this dialog.  
 
 
 
 
 
 
 
 
Complete the “Regression” dialog box as follows: 
 
- Specify “Unit Sales” as the “Input Y Range”. We will be turning on the “Labels” option 

in this dialog, so include the column header cell (Cell E9) in your Unit Sales 
range specification1. This range is E9:E57. 
 

- Specify the range of data in Columns F through K as the “Input X Range”. Include only 
one row of column headers with your range specification. That is, include the 
labels in Row 9 but not those in Row 8. This range is F9:K57.  
 

- In the “Regression” dialog box make sure the Labels box is checked. Excel will 
recognize that the first cell in each column of data is that column’s label. 
 

- Direct Excel to put its results on a new worksheet by choosing the option New 
Worksheet Ply. 

 
- For outputs, select Residuals, and Standardized Residuals. 
 
With data ranges and choices specified, your dialog should now look like the one below. 
 

                                                      
1 In this selection operation be careful to select data and header only and not an entire column. Here’s an 
easy way to select just the contiguous data from a column of data: Click the top cell. Depress the SHIFT 
key. Tap the End key and then tap the down arrow key. Excel selects all data down the column until it 
reaches the first empty cell in the column. 
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- Click OK to execute the regression. 
 
The New Worksheet Ply default output option means that Excel locates the regression 
outputs on a new, separate worksheet that it creates and puts to the left of the worksheet 
that holds the original data.  
 
Excel completes the regression analysis 
leaving a large range of the worksheet 
selected. Click any cell to turn off the range 
selection. Because the Regression tool 
generates many outputs on a single sheet, 
you may want to use Excel’s Zoom Control 
option to reduce the new worksheet size in 
order to get a view of how the outputs are 
arranged. 
 
Widen the columns on the new worksheet 
in order to see all the text results properly. 
A quick way to do this is to select the blank square at the intersection of the row 
numbers and column headers (to select the entire worksheet), and then double-click the 
dividing line between any two column headers. Excel widens each column so the widest 
entry in that column displays completely. 
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To rename this worksheet “Task 1” right-click the worksheet tab and enter the name in 
place of the default worksheet name. 
 
Task 1 Intermediate Check 
Selecting the Residuals, and Standardized Residuals options in the “Regression” dialog 
produces the output partially shown below.  
 
In this view columns have been widened to show the results completely.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Excel labels the output areas “SUMMARY OUTPUT”, “ANOVA”, and “RESIDUAL 
OUTPUT”. 
 
3. Create a Chart  
Create a line chart comparing the actual Unit Sales in the “Task 1–Pie Data” worksheet 
with the Predicted Unit Sales produced by the regression analysis.  
 
 
 
 
 
 
 
 Partial view of Excel’s regression output                               Partial view of the “Task 1 - Pie Data” 

showing the “Predicted Unit Sales”.                                      worksheet showing “Unit Sales”. 
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The data needed to create this chart are located on two different worksheets. The Unit 
Sales data is on the original “Task 1–Pie Data” worksheet. The Predicted Unit Sales 
data – output by the regression analysis – is under the “Residual Output” header on the 
worksheet of outputs you just generated and now named “Task 1”. 
 
To create a chart using data from two 
different sheets: 
 
1. Select the Predicted Unit Sales 

(Predicted Y) header cell and the 
data beneath it from the regression 
output. Click the “Insert” tab and 
from the “Charts” group select a 
line chart style from the “2-D Line” 
group.  
 
Drag the chart to the right of the 
RESIDUAL OUTPUT section of the 
worksheet. The basic chart and its 
location in relation to the outputs 
on your “Task 1” worksheet should 
look like the illustration below. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

2. Make your “Task 1–Pie Data” worksheet current. Select the Unit Sales header cell 
and the data beneath it from this worksheet. Copy the selection to the Windows 
Clipboard using Edit, Copy (or CTRL+C). 

 
3. Make your “Task 1” worksheet current. Select the outside edge of the line chart you 

just created. Small, empty circles and squares should appear around the edges of the 
chart to show it’s properly selected. 
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4. With the chart selected, use the Edit, Paste commands (or CTRL+V) to copy the data 
from the Clipboard to the chart. Excel adds the data from the clipboard to the 
existing chart as a second line. 

 
Task 1 Check 
A simple line chart with sales data from the 
two worksheets should appear similar to the 
chart shown at right. You need not make any 
formatting changes to this cart. In the 
illustration here, it’s a bit hard to see both 
lines, but the legend at right indicates that 
two data series are included in the chart. 
 
 
 
 

 
 
 
 
Optional Enhancement  
At left is a chart modified to 
include a title, formatted X and 
Y axes, and a modified legend. 
 
You need not reproduce these 
modifications in your own chart. 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 

End of the Task 1 Detailed Description 
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Range Naming Note 
You need not name the ranges of data you plan to use in an Excel analysis, but being 
able to work with named ranges can be helpful. When the data already has headers (as 
does the data we used in Task 1), a quick way to assign names to all the variables is to: 
 
1) Select all the headers from the “Unit Sales” header to through “Time Var”. Note that 

some of the data columns have 2-row headers, but Excel allows only the contents of 
a single cell to be a range name, so select the single row of headers closest to the 
data. 

 
 
 
 
 
 
 
 
 
 

Depress and hold down the Shift key, tap and release the End key, and tap and 
release the down arrow key. Release the Shift key. Excel selects all the data beneath 
the selected headers for you. 

 
 
Partial view. 
 
 

 
2) Next, click the “Formulas” tab and find the “Defined Names” group. 

 
3) Choose the “Create from Selection” button. Excel opens a “Create Names from 

Selection” dialog. 
 
 
 
 
 
 
 
 
 
 
 
 
 
4) Choose the “Top row” option in this dialog and click OK.  



 
 
 
 

Stats Regr  11 

Statistics and Regression Tools Review: Detailed Descriptions 

 
Excel uses the text in the top row of each column of data 
as the range name for that column.  
 
Choose the “Name Manager” button in the same “Defined 
Names” group to open a dialog that displays all the 
named ranges in your workbook. The names from the 
selected headers in the pie data should be listed in this 
dialog. 

 
You can now use any of these names in place of their corresponding range references to 
refer to those ranges. For example, the range E10:E57 can be referred to by the range 
name  “Unit Sales”.  
 
Additional Notes 

 A range named in this way (using create from selection) does not include the header 
cell that provides the name.  

 If a header consists of two or more words separated by spaces, Excel automatically 
replaces the spaces with underscores in the range names.  

 Two other ways to create a range name: 
- Use the “Define Name” option in the “Defined Names” group on the Formulas “ 

tab. 
- Use the “name box” at the left-hand side of the formula bar. 
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Task 2: Use Excel’s Descriptive Statistics Generator to Analyze Data 
 
Excel has a wide variety of built-in functions 
and tools for performing statistical analyses. 
For example, Excel includes over 80 functions 
in its “Statistical” category of built-in 
functions. Clicking the Paste Function button 
on the Formula Toolbar displays an “Insert 
Function” dialog showing Excel’s built-in 
functions. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

These functions in particular are often used for projections: FORECAST, TREND, 
GROWTH, LINEST, and LOGEST. In addition to the built-in functions, a number of 
statistical analysis tools besides regression are included in Excel’s Analysis ToolPak add-
in (Tools, Data Analysis). 
 
In this task you use the “Descriptive Statistics” data analysis tool to generate descriptive 
statistics about a set of car import data and rearrange the results to make the data more 
readable.  
 
 

The “Data Analysis” button is located on the 
“Data” tab in the “Analysis” group. 
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Make the “Task 2 - Auto Imports” worksheet current. This worksheet contains data on 
imports into the U.S. passenger car market from 1971 to 1997, comparing Korean, 
Japanese, and German import sales with sales of passenger cars manufactured in North 
America.  
 
Choose the “Data” tab and find the “Analysis” group. Click the “Data Analysis” button. 
Select the “Descriptive Statistics” option to open the dialog for that tool. Complete the 
“Descriptive Statistics” dialog as follows: 
 
1. For “Input Range” specify all columns of data except for the “Year” column in the 

analysis. Do not include the “Year” data. Include column headers when you select 
the Input Range (the range C9:F35). 

2. Check the “Labels in first row” option. 
3. For “Output options” choose “Output Range” and specify a cell below the data (for 

example, Cell B38).  
4. Request all the available outputs: Summary statistics, Confidence Level for Mean, 

Kth Largest, and Kth Smallest. (Leave the defaults for these last three output options 
as they are, at 95%, 1, and 1.) 

5. Click OK. 
 

 
 
 
 
Excel automatically 
converts any cell 
references you enter in 
this dialog to absolute 
references. 
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Columns with redundant labels 

Excel generates a complete set of descriptive statistics for the data that looks like the 
illustration that follows. 
 
Task 2 Intermediate Check 
The initial results remain selected; click any cell to deselect the range. In this “raw” 
output, many columns are not wide enough to display their data completely. In 
addition, Excel generates a column of descriptive statistics labels (Mean, Standard Error, 
Median, etc.) for each country/region analyzed (Columns B, D, F, and H). This label 
redundancy makes the output more difficult to read. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Widen columns so all the data is visible and edit the output so it has a single labels 
column at the left of the data. Arrange the output so country/region names are above 
their data. Use Excel’s delete and move options to rearrange the data.  
 
 
 
 
 
 
 
 
 
 
 
 
 

For example, select the 
data for Japan and drag 
it to the left. 
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Task 2 Check 
With these changes complete, your output will look like the illustration below. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 

End of the Task 2 Detailed Description 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

End of the Statistics and Regression Tools Review Detailed Descriptions 
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Statistics & Regression Tools Review Skills Summary 
 
 
Import a Text File into Excel 

Use Excel’s normal File, Open commands. A 
3-step “Text Import Wizard” dialog opens. 
Complete the wizard steps to specify the data 
type, characteristics, and import formats. Also 
use the wizard to determine which columns of 
data to import and the import starting row. 
Once a text file is imported into Excel 
it remains a text file until converted to 
Excel format by clicking the Office button, 
then Save As, and then Excel Workbook. 
 

 
 
 
 
Excel’s Analysis ToolPak 

 
To Access 
From the “Data” tab and the “Analysis” group, click the “Data Analysis” button to open the 
“Data Analysis” dialog. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
The Analysis ToolPak is a part of MS Excel. It’s packaged as an add-in. It’s available if 
you have loaded the add-in during your Excel installation and if you’ve turned it on as an 
available add-in. 

 
Tools 
Provides functions and interfaces for financial and scientific data analyses. 
 
Operation 
From the “Data Analysis” dialog select the analysis you want to perform and then 
complete the dialog that displays. The dialog prompts for input data, output 
specifications, and (in many cases) run-time options. 
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Run a Regression Analysis Using Excel’s Built-In Regression Tool 
Excel’s built-in regression analysis tool is part of its Analysis ToolPak add-in.  
1) Open the “Data Analysis” dialog (see the notes above.) 
2) Choose Regression from the 

list of options in the “Data 
Analysis” dialog that displays. 
A “Regression” dialog opens. 

3) Complete the “Regression” 
dialog, specifying inputs (the 
dependent (Y) variable and 
the independent (X) variables 
and outputs. Note that range of 
X variable values  must be located 
together in the worksheet.  

4) Choose OK to run. Excel 
generates regression results. 

 
 
 
 
 
 
 
Chart Data from Different Worksheets 

1) Create a chart using the data from one worksheet. 
2) Select and copy the data from the other worksheet. 
3) Go back to the initial worksheet-with-chart and click the chart’s edge to select it. 
4) Edit, Paste the copied data onto the chart. 

 
 
 
Find a List of Excel’s Statistical Functions 

On the “Formulas” tab choose the “Function Library” group and click the “Insert Function” 
button. Choose “Statistical” from the category list to see a list of built-in functions that 
handle statistical operations. 
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End of the Excel Statistics & Regression Tools Skills Review Summary 
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